Introduction to Windows NT 4.0 Server

Module 1: The Microsoft Windows NT 4.0 Environment

Topics:

Microsoft Windows operating systems

Windows NT architecture overview

Domains and workgroups

Features of NT 4 Workstation

Internet Explorer

Personal Web Services

Security


Desktop Services

Limited licensing

Messaging Services

Stability and Performance benefits (compared to W95/98)

multiprocessor support  (2 cpus)

Windows NT Workstation is not plug and play

it requires hardware profiles for docking station connections
a maximum of 10 users are  permitted to log on to NT Workstation  (this is not physically enforced)
NTWorkstation does not support network logon, but does provide sharing and security services
For adequate security protection, the latest NT service packs should be installed

Although NT Workstation machines can be used as servers, they lack some sophisticated features of NT 4 Server

Additional Features of NT 4 Server

Directory Services (Domains vs. Workgroups ) 
Microsoft Internet Information Server

Administrative Wizards



Network Services (DHCP,  WINS, DNS, FTP, Mac support)

256 inbound connections through RAS

Fault Tolerance (hard disk mirroring)

Similarities and differences compared to Windows 95/98

They have the same general desktop interface:


Q. What do you have to do to get the toolbars and Outlook Express to appear after a basic installation?

The original version of Windows NT 4 ships with Internet Explorer v. 2.  It may be upgraded by Service packs downloaded from Microsoft website.  Later CD versions of NT ship with Internet Explorer 3 and 4 included.   The current urrent service patch is SP6a.   Active Desktop can be added to NT along with Internet Explorer 4 or 5.

No DOS underneath the NT GUI

     Graphic interface is part of the system kernel.  The DOS command prompt within the OS is emulated.

     What can you do if Windows NT won’t boot?

     How can you get command-line access if the GUI won’t load?

All programs (both Windows and DOS) can run in separate, protected memory address spaces.

No Plug and Play

     Installing new devices and fine-tuning performance is done through different Control Panel

     Applications than under Windows 98.

NT has a slightly different Start Menu

               The Start Menu is divided into common program groups and groups specific to each user.
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Windows NT Administrative Tools group

Administrative Wizards  provide guided walkthroughs of basic tasks (these can also be accomplished directly through individual administrative applications).

Disk Administrator lets you control disk partition defaults – replaces MS-DOS FDISK

Event Viewer (provides diagnostics on features that don’t start up properly)

License Manager (records license information for OS and applications)

Remote Access Administrator   (controls Remote access privileges of clients)

Server Manager  (allows you to manage existing network shares and see who’s using them)

User Manager  (core application for creating and administering user accounts.  If the computer is a Primary domain controller, this is accomplished through the User Manager for Domains.)

Windows NT Diagnostics  (provides some limited troubleshooting features – a less powerful version of Windows Device Manager).

Domains vs. Workgroups

A workgroup is a collection of computers linked informally into a physical network to share software and hardware resources.   Workgroups usually follow a peer-to-peer network architecture

A domain is a collection of  computers serving users with common access needs from a centralized server. Domains usually follow a client-server network architecture

In a workgroup each server maintains an individual user account database

in a Domain, there is a common user account database.

A Windows NT 4 domain must include a Primary Domain Controller in addition to client workstations (NT4, W95/98 or other operating systems).  The domain  may also include a backup domain controller and member NT servers.,

Managing Windows NT Server Domains (From Help Resources on NT disk

Deciding on a Domain Model

A domain model is a grouping of one or more domains with administration and communications links between them (trust relationships) that are arranged for the purpose of user and resource management.

A Windows NT network can use either the domain or the workgroup model.   Workgroups are the same as in Windows 95/98 and generally have more independent client machines.  The workgroup model is used on smaller networks.

*During installation of Windows NT Server you get to choose whether the machine will join a domain or a workgroup.  If it’s the first machine in the group, you have the option of making it the Primary Domain Controller.

By properly planning and organizing the domains on your network, you can simplify network administration and ensure that all users can connect to available resources throughout the network. For example, you can set up your domains so that all user accounts and global groups are valid in all domains. 

Because one domain can accommodate up to 26,000 users with individual workstations and approximately 250 groups, a single domain is suitable for most applications. To decide how many domains your organization needs, take into account the work structure and number of users. Windows NT Server domain models provide the flexibility needed for different organizations:

·
Organizations with many small branch offices

·
Large organizations

·
Security for sensitive information

In addition, expansion is easy. Offices can start out with separate domains and can link to each other later or can be added to existing domains.

Your first consideration is the size of your organization because the size of the directory database determines how many domains you need.

In most cases, you can use the single domain model. In this model, the network has only one domain. You create all users and global groups in this domain. The single domain has a PDC with one or more BDCs. The PDC and each BDC can support 2,000 to 2,500 user accounts to validate user logons and provide fault tolerance. The number of accounts could be as high as 5,000, depending on the power of the computer.

Single domain model

The single-domain model is an appropriate choice for organizations that require both centralized management of user accounts and ease of administration. Any member of the Domain Administrators group can administer all network servers and domain accounts on the PDC.

A network can use the single domain model if it has a small enough number of users and groups to ensure good performance (generally up to 26,000). The exact number of users and groups depends on the number of servers in the domain and the hardware of the servers.

Having a single domain also means that all your network administrators can administer all network servers. Splitting a network into domains enables you to create administrators who can administer only some servers, such as those in their own department.

Managing Domains

Windows NT Server and Windows NT Workstation security policy settings can provide different levels of security for user actions on domain controllers and on workstations and member servers. Domain security policy should be worked out in advance as part of planning your domain. 

When administering domains, security policy applies to the primary and backup domain controllers in the domain (they share the same security policy). When administering a computer running Windows NT Workstation or a computer running Windows NT Server, security policy applies only to that computer.

You can define three security policies:

·
The Account policy controls how passwords are used by user accounts.

·
The Audit policy controls what types of events are recorded in the security log (which you can view in Event Viewer if you are logged on as a member of the Administrators group).

·
The Trust Relationships policy controls which domains are trusted and which domains are trusting domains. This policy is not used in the Single Domain model and is not available when administering a computer running Windows NT Workstation or a computer running Windows NT Server as a member server.

A fourth security policy, the User Rights policy, is applied to groups or users and affects the activities allowed on either an individual workstation or member server, or on all domain controllers in a domain. 

For information about the User Rights security policy, see Chapter 2, “Working With User and Group Accounts.”

For information about trust relationships, see “Administering Trust Relationships,” later in this chapter.

For information about planning domains and creating trust relationships in multiple-domain models, see the Windows NT Networking Guide in the Windows NT Server Resource Kit version 4.0.

Directory Services Video:  summary

An administrator can manage the network from any computer

Account information is stored in a common directory database

1 PDC per domain, multiple BDCs are permitted

BDCs can validate logons if PDC is offline, but don't permit account modifications or creation of new accounts

PDCs can synchronize account information with BDCs

Large organizations may use multiple domains with trust relationships

Users can log on to a trusted domain and be validated by their home domain (each domain database is separate)

Logging on to a Windows NT Server

Press Ctrl+Alt+Del     Why?

Networking

Network Architecture -- Review

Required components for a network connection


Client


Network Adapter


Protocol



NETBEUI



NWLink  (IPX/SPX)

           

TCP/IP

See  http://userwww.sfsu.edu/~lennyb/edsite/chap25_1.htm)

Configuring Networking - Open Settings, open Control Panel, open Network, the Network Setup window

has tabs for Adapters, Protocols, Services, Identification and Bindings

Adapters - Select the type of network adapter and the IRQ and I/O Port address

Protocols - Only load the protocols necessary, additional protocols add overhead to the system

NETBEUI - Used for Microsoft clients on the LAN, good for print and file sharing

IPX/SPX - Used in existing Novell environments and where there is heavy client/server traffic

TCP/IP - Used in Intranets and the Internet, also good for printing, file sharing, and client/server

applications

Under the configure button there are several fields that must be filled out correctly for TCP/IP to fimction

IP Address - The IP address of this interface. Usually assigned by the network administrator

Subnet Mask - The number of bits of address space used for network addressing

Default Gateway - The IP address of the router on the LAN

Domain Name Servers - The IP addresses of DNS servers used to resolve host names to IP addresses

WINS - The IP address of the Windows Internet Naming Service server used to resolve local host' names to

IP addresses. This can he used when local hosts do not have static IP addresses

Routing Tab - Allows you to use the NT server to route packets between different interfaces

One of the more popular uses of this ftmction is to route IP packets between an Asynchronous interface

(running RAS) and an Ethernet interface

Sharing Files and Printers

File Shares

Creating Shares using the Wizard - Open Programs, open Administrative Tools, open Administrative

Wizards, open Managing File and Folder Access, A setup wizard will ask for the following information to

set up Shared Volumes:

Where the shared folder and files reside - On this computer, or on another computer

Select the path to the folder to be shared

Set the file access permissions

Select a name for the shared folder and what type of clients have access to it

Creating Shares using the Explorer/File Manager - Use the Explorer or My Computer to locate the directory to be shared, select the directory, right click the directory and select the sharing menu, enter the name to the will be called, the number of users that can access the share, click on the permissions button, use the Add and Remove buttons accordingly to grant users access to the share and set the file permissions to Full Control, Read, Change, or No Access

Sharing Printers

NT Server can manage locally attached printers as well as printers attached to other computers. The advantages of allowing NT Server manage printers attached to other printers are access control and the print queue resides on the server, not the hosting computer.

Configuring a Printer - Open the Control Panel Settings menu, select the Printers option, click on the Add Printer icon. A set-up wizard will guide you through the configuration. After setting up the printer the wizard settings may be reoptioned and other settings such as Job Scheduling, and Security may be configured by selecting printer properties from the Control Panel, Printers screen

Sharing Printers - Open Settings, select Printers, choose the File menu, choose the Properties menu, under the Sharing Tab set the Share Name, Under the Security Tab define who has access to the printer.

User Administration

User Manager

The User Manager (or User Manager for Domains) Tool allows adding of a user and setting the administrative properties of a user on an NT Server, and Workstation in a Workgroup or a Workstation in a Domain. New users may be added in either the User Manager or the Wizards.

Adding a New User - Open Programs, open Administrative Tools, open User Manager, choose User menu, choose New User, enter the User Name, Full Name, Discription, Password, click OK.

Group Properties - The Groups function in the User manager allows adding or modif'ying groups. To add a group, from the User menu, select New Local Group (to the domain) or New Global Group. To modify an existing Group, select the Group and choose properties from the User menu.

User Properties - The User Properties window allows the adding or modification of logon properties of users. This is where user accounts can be disabled. The Account Lockout occurs after repeated logon failures, with no automatic reset tirne.

Group Memberships - On the bottom of the Users Properties page is the Groups button. The Gtoup

Membership window allows the setting of memberships of users in groups.

User Environment Profile - The Profile button on the Users Properties page allows the setting of the User

Profile (edited by the User Profile Editor), Logon Script and the Home Directory Path.

Logon Hours - The Hours button on the Users Properties page allows the setting of allowable hours the user can connect to the server. The user will not be logged out of the server if logged on before the blackout period (if specified).

Logon Workstations - The Logon to button on the Users Properties page allows Itmiting which workstations a user may logon to.

Account Information - The Account button on the Users Properties page allows setting when the users account expires and if the account is Local or Global.

Policies

The next set of configurations are for the entire NT Server, not configuration of individual users, they are all reached from the Policy menu of the User Manager:

Account Policies - This is where the settings for Password Expiration, Mniiimum Password Age, Minrtnum Password Length, Password Uniqueness, and Account Lockout on failed logon attempts are set.

User Rights Policy - This window allows setting permissions for groups to perform a number of sensitive fianctions such as shutting down the system.

Auditing - From the Auditing Policy window auditing may be enabled to track a variety of system events.

Trust Relationships - A Domain may enter into a trust relationship with other Domains, where they will honor global user accounts on the other Domain's Server. Trust accounts are one-way, each Domain must configure their trust for each other to enable a two way trust arrangement.

Introduction to User Accounts

There are three types:

Guest – supports multiple users for occasional or limited access (WinNT disables this by default)

Administrative – Manage users and groups, security policies,  printers and shared resources



(The Administrator account is part of an Administrators group)

Accounts you create –  for individual users and your own organizational groups

Accounts are created in the User Manager tool (for a workgroup computer) or the User Manager for Domains tool (for a domain-wide account.)

With a domain user account a user can log on to the domain from any computer on the network, using the same username and password.

A local user account defines a user for one local computer.  The user can log on to that specific computer and access its resources, only.  Without a domain account, a user must log on to each computer on the network separately to access its resources.

Groups in User Manager allow delegation of privileges.

What’s the advantage of creating groups instead of defining privileges for each individual user?

Planning Considerations for New User Accounts

· Naming convention:  use a naming strategy that provides unique but consistent account names.

· Password requirements:  Decide what your password enforcement options will be (including whether a user can or must change their password.

· Logon hours

· Workstation restrictions: determine which computers on the network the user can work from.

· Home folder location:  establish a home folder for each user on a centralized server or on a local computer.

Usernames can contain up to 20 uppercase or lowercase characters, with the exception of the following: / \ [ ] : ; | = , + * ? < >.   Alphanumeric and special characters can be combined in a username or password.

What would be an easily managed  naming convention for large number of users? What if two users have the same first and last names?

Always assign a password to the Administrator account in a real network where a server can be accessed by a number of users.

Determine who will control the passwords.


Who controls passwords if users can’t change them?


Who controls passwords if users are required to change them?

Determine whether accounts need to expire?  Why would you want to set an expiration date on an account or not set one?
What should you (as an administrator) tell users to avoid in choosing a password?

Effects of creating a home folder for a user:

· The folder becomes the default when the user chooses File->Open in an application

· The folder is the default when the user chooses File->Save in an application.

· The folder is the default directory when the user opens a DOS command prompt.

Why would you want to place home folders on a network server?

Creating User Accounts
Open User Manager for Domains (or User Manager) and choose User->New User
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In User Manager on a workgroup server the Hours,  Logon To, and Account buttons are not present.

Account names must be unique to a domain

Local account names must be unique to a local computer

How can you tell which kind of account will be created when you choose User->New User?

Other account restrictions/permissions:

Logon Hours, Logon To

Dial-In Permission

Account Options allow you to set an expiration date  (the Local Account option is generally not used in a single-domain model.)

All user accounts can be renamed.  All accounts other than the Administrator account can also be deleted.

(For security purposes, you may want to rename the Administrator account to make it harder to break into.)

----------------------------------------------------

About Groups

Permissions are rules that regulate which users can access a resource, such as a folder, file or printer.

User rightsd are rules that regulate which users can perform certain tasks on the system, such as creating a user account, logging onto the local computer, adjusting the hardware configuration, etc.

In Windows NT 4 there are two kinds of groups, Local and Global

Global groups are intended to contain and organize user accounts.

Local groups are intended to define permissions and user rights.

A user can be a member of one or more groups.  A user who is a member of more than one group possesses all user rights and permissions of all groups that he or she belongs to.   (The “No Access” restriction is a joker.  If a user belongs to a group that has No Access to a resource, this bumps the access rights the user may have as a member of other groups.)
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How can you tell the difference between a Local and a Global group in User Manager?
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Local groups provide permission to access resources or perform system tasks. Generally a local group is associated with specific tasks or access rights.  (Ex: Server Operators, Backup Operators, Web Users.) You assign  permissions and rights to a local group, and then place individual user accounts or global groups within a local group to pass these permissions on to your users.

Global groups are used to organize domain user accounts (usually by the user’s function in the company or geographical location, ex: Northwest Users, Accountants, Engineers.)

Although global groups can be used to assign permissions to resources (all accounts have full control over the billing folder), the best practice is to use global groups only for grouping domain user accounts and assign resource permissions by adding a global group to a local group.

(Show Groups Video)

Review Questions:

What’s the purpose of a local group?

What’s the purpose of a global group?

Where are local groups created?

Where are global groups created?

Exercise 1





Computer   --   PDC
Computer 2  --  BDC
Computer 3 -- Member Server

World Wide Importers
Accounts Payable
Inventory



The Paris office of World Wide Importers has a single-domain network with a PDC, a BDC, and a member server (non-domain controller).  The BDC also has an accounts payable database and the member server has an inventory database.   All users need to access both databases.

1. On which computer would you create a global group for organizing the user accounts?  Why?


2. On which computer would you create a local group to provide users with access to the Accounts Payable database?  Why?


3. On which computer would you create a local group to provide users with access to the Inventory database?  Why?


4. How would you give members of the global group access to both databases?

Built-in Windows NT4 Groups

Table 12.1 Windows NT User Groups That Have Permission to Administer User Accounts and Groups

Windows NT 
User Group
Group Description

Administrators
A local group whose members can perform all user and group management functions.

Domain Admins
A global group that, in most cases, is a member of the Administrators local group. As a member of the Domain Admins group, the user is automatically given local Administrator privileges.

Account Operators
A restricted account whose members can manage most properties of user accounts and groups. A member of this group can't manage the following Windows NT Server groups: Administrators, Domain Admins, Account Operators, Server Operators, Print Operators, and Backup Operators. Members of this group also can't manage the account of domain administrators and can't alter domain security policies.

Examining the Built-In Groups of Windows NT Server 4.0

The actions that a user account can perform depends on the group memberships assigned to the user account, the rights and privileges the user account inherits from the group(s), plus specific permissions assigned to the account by the account administrator. Windows NT Server 4.0 has 11 built-in user groups, each with a pre-established set of permissions for use of network resources. Descriptions of a few of these groups, by necessity, appear earlier in this chapter but are repeated here for completeness. Following is a brief description of each built-in user group, in the approximate order of decreasing privilege:

· The Administrators group is the most powerful local group in the domain. The administrators are responsible for the overall configuration of the domain and the domain's servers.


· Domain Admins is a global group that's a member of the Administrators group. By default, members of the Domain Admins group are as powerful as the Administrators group. The Domain Admins group can be removed from the Administrators group, if necessary, to restrict the group's authority.


· Users is a local group that provides the capabilities that most users need to perform normal tasks. Members of this group have no rights to administer servers running Windows NT Server 4.0.


· Domain Users is a global group that's a member of the local Users group. By default, all new accounts are automatically added to
this group, unless the account is specifically removed by the account administrator. 

· Account Operators is a local group that allows its members to use the User Manager application to create new groups and accounts. Members of this group have limited capabilities to administer accounts, servers, and groups in the domain. Members of this group can't modify or delete accounts or groups belonging to the Administrators, Domain Admins, Account Operators, Backup Operators, Print Operators, or Server Groups. Account operators can't administer account policies.


· Backup Operators is a local group that can back up and restore files on the domain's primary and backup controllers. Members of this group also can log on to a server and shut down the server, presumably for backup operations.


· Print Operators is a local group that allows its members to create and manage printer shares in the domain. These members also can log on to a server and shut down the server.


· Server Operators is a local group that allows its members to manage the domain's primary and backup controllers. This group's members also can manage folder and print shares, as well as administer server functions such as setting system time for the entire domain.


· Replicator is a local group that supports the capability to perform folder replication functions. Only accounts needed to log on to the Replicator services of the primary and backup domain controllers should be members of this group.


· Domain Guests is a global group that's a member of the local Guests group. This group is intended for user accounts that have more limited rights than a member of the Domain Users group.


· Guests is a local group with very limited capabilities. This group is used for occasional or one-time users. 
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Planning Group Strategy

· Organize users based on common need

· Create global groups and add users to them

· Create local groups based on resource access needs

· Assign permissions to local groups

· Assign global groups to local groups

Group names on a single domain must be unique (they may be duplicated on other domains)

(The Select Domain button allows an administrator to manage accounts on another domain if the administrator also has privileges to do so on that domain.)

· Deleting a group doesn’t disable the user accounts that were a member of that group

· The Guest group can’t be deleted

· Groups cannot be renamed.

· Built-in Windows NT groups cannot be deleted or rebuilt. 

Exercise 2

Accounts need to be create for the following personnel at McDuck Industries.  For now, the company will be placing both its Accounts and Inventory databases on the Primary Domain Controller.

Username
Name
Description


Gyro Gearloose
Network Administrator


Donald Duck
VicePresident


Scrooge McDuck
President


Huey Duck
Sales Manager


Dewey Duck
Accounts Manager






Louie Duck
Sales representative


Minnie Mouse
Account representative





Huey and Dewey should not be full administrators, but Gyro would like them to be able to back up the server.

The administrator, all the executives, and managers need to be able to access both the Accounts and Inventory folders.  However, when new representatives are hired (such as Louie and Minnie), they should only be given access to the folder that contains the database for their own department.

Donald is not to be trusted with any system maintenance tasks and Scrooge doesn’t want to be bothered.

How can the account structure for this domain be set up?

Hints:  Who should be placed in the Domain Administrators Group?

           Create a group called Executives  (should this be local or global?  Who should be a member?)

           Create a group called Managers (should this be local or global?  Who should be a member?)

           Create a group called Sales Reps to access the Sales database (Should this be local or global?

                 Who should be a member?)

           Create a group called Account Reps to access the Accounts database (Should this be local or global?
                   Who should be a member?

           Create a group called Account Personnel to access the Accounts database (local or global? 
               Who  should be a member?)

          Do you need to place any individual user accounts into a local group? (This should be avoided)

          How can Gyro be made a local administrator?

           Into which local group(s) should you place the Executive group?

          Into which local group(s) should you place the Managers group?

          Hint: how can Huey and Dewey be allowed to back up the server?  Does either
                   need to be placed directly into a local group?

           Create two new folders on your PDC called Accounts and Inventory.

           Share these folders and go to the Permissions tab for each.

          Do any individual user accounts need to be given direct access permission to either folder?

         Which group(s) should be given access permission to the Inventory database

          Which group(s) should be given access permission to the Accounts database?

Adding Local Groups

The built-in user groups are adequate for most Windows NT Server 4.0 networks. If you have a large, complex network, you might want to define your own user groups by, for example, organizational function or department. As an example, members of the Finance, Marketing, Sales, and Production departments might have their own group. Similarly, vice presidents, directors, managers, and supervisors might be assigned to their own group.

To add a local group to the domain, follow these steps:

· From User Manager's User menu, choose New Local Group to display the New Local Group dialog. 

· In the Group Name text box, type a group name that's no longer than 20 characters. A Group Name is required.


· Type a group description in the Description text box. Although this is optional, a meaningful description is useful as your network grows and more groups are added. 

To add user accounts to the new group, click the Add button to display the Add Users and Groups dialog (see fig. 12.32). To add users to the local account, follow these steps:

· Select the account entry in the Names list and click the Add button, or double-click the entry in the Names list to add the account to the Add Names list. (A description of each option in the Add Users and Groups dialog follows.)


· Repeat step 1 for each additional account you want to add to the new group.


· Click OK to add the accounts to the new group and close the Add Users and Groups dialog. 

Defining and Managing User Profiles

To further define a user's profile, the Profile button lets you select custom settings for one or more users. Clicking the Profile button displays the User Environment Profile dialog, shown in figure 12.12.

Setting user environment parameters in the User Environment Profile dialog.
User profiles provide power and flexibility for system administrators and users when configuring a network environment. User profiles are typically stored in a common folder on a Windows NT server. Windows NT Workstation clients also can have individual user profiles to supplement the user profile stored on the Windows NT server.

User profiles specify the startup information when individual users log on to Windows NT. This information includes the user environment (environment variables, paths, and mapped drives), program groups, and available applications. When a user profile is stored on a central NT server, the user environment is the same regardless of the computer the user logs on from. When the user profile is stored on individual NT machines, the environment reflects the settings stored on each machine.

User profiles also can contain mandatory settings that you assign; users aren't allowed to alter these settings. This procedure ensures a standard working environment for each user and relieves the problems that result from erroneous changes made to a user profile, such as deleting a Start menu folder or shortcut.

Specifying the User Profile Path.

The user profile is specified in the User Profile Path text box, which contains the location of a user profile located on a Windows NT server. If the text box is empty, the profile is stored locally on each machine that the user logs on to.

Two types of user profiles are available:

· Personal User Profiles. This profile type is assigned to each user and can be altered by the user. Each user has his own private profile file with the file extension .DAT or .USR.


· Mandatory User Profiles. This type of profile is assigned by the system administrator and can't be changed by the user. A mandatory user profile has the file extension .MAN. 

To assign a profile to a user account, type the profile path and file name in the User Profile Path text box. Be sure to follow the UNC naming convention. For example, to store a profile named Profile.usr on the computer BEDROCK in the folder Users, type \\bedrock\users\ntuser.dat
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NOTE: When using mandatory user profiles, the following rules apply: 

· Mandatory profiles are added in the same manner, with the exception of the file extension (.MAN).


· Unlike an individual user account, a mandatory user account must be created by the account administrator with User Profile Manager. This account must then be placed in the location specified in the profile path. If a profile isn't created, users with mandatory profiles aren't permitted to log on to Windows NT. 

To assign home folders

1. On a server, create a folder named Users.  Share the folder and assign Full Control permission to all users so they can connect to it.

2. Open the user account in User Manager and click the Profile button.

3. Specify a home fodler name and location for a user account in the User Environment Profile dialog box. (You can do this manually for each user, ex. \\Server\Users\John Smith or you can use an automatic variable that will associate individual usernames from a template account, ex: \\Server\Users\%Username% )

The home folder is the default folder in which a user is placed when starting a DOS-command session. When the user logs onto a domain remotely, a home folder created on a server can automatically be mapped to a local drive letter on the computer the user is logging in from.

· In the User Environment Profile dialog, select the Connect option.


· From the drop-down list box, select the drive letter of the client machine to contain the home folder.

The home folder also is used as a repository for user files. The home folder can be a folder located on the client's local fixed disk as well as on a network drive.

To set up a home folder on a local machine, perform the following steps:

· In the User Environment Profile dialog (accessed by clicking the Profile button), select the Local Path option.


· Type the local path (for example, c:\users\default) in the Local Path text box. 

Setting a Logon Script Name.

Logon scripts are optional batch files that are run whenever a user logs on to a Windows NT network. Logon scripts are tailored to the client operating system that's used to log on to the network. All client operating systems for Intel PCs, except OS/2, use the .BAT extension for the script file (OS/2 uses the .CMD extension).

Logon scripts aren't as flexible as user profiles but can be used instead of user profiles or with user profiles. By default, all logon scripts are stored in the folder \\SERVERNAME\Winnt\system32\Repl\Import\Scripts, where SERVERNAME is the UNC server name of the primary domain controller for the domain you're administering. Because all scripts are stored in a central spot, only the name of the script file needs to be entered in the Logon Script Name text box. You can change the location of the Scripts folder by using Server Manager.

If a relative path is entered in the Logon Script Name text box, such as \Users\Logon.bat, it's appended to the stored folder path. Using the preceding example, the logon script is run from the folder \\SERVERNAME\Winnt\system32\Repl\Import\Scripts\Users\Logon.bat.

Logon scripts can be assigned on an individual basis, or the same logon script can be assigned to multiple users.

Windows NT Control Panel -- Notes
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*=important applet:

Add/Remove Programs – similar to Windows 98 

Console – sets MS-DOS options

*Devices – presents list of installed hardware devices, allowing you to start and stop on a case-by-case basis

Dial-Up Monitor – dial up network diagnostics

Display – similar to Windows 98

Internet – similar to Windows 98

*Network – controls hardware/software network settings.  Much more complex than Windows 98

         Important services: 


 RAS – remote access service to let users dial in to network via modem

 
IIS   Internet Information Server – web server

  
DHCP – Dynamic Host Control Protocol – automatically assigns IP addresses to client machines


WINS – Windows Internet Naming Service – matches IP numerical addresses with NETBIOS
              names  (proprietary Microsoft service)


DNS     Domain Name Services – matches IP numerical addresses with computer names
                           this is a more general naming service that complies with UNIX and other platform
                           standards

SCSI Adapters – controls ordinary ATAPI (IDE) CD-ROM devices and tape backup as well as SCSI hard disks

Server – provides status on currently shared folders and users logged into the domain

*Services – lists all currently running Windows NT services, allowing you to start and stop them manually 
                   or automatically.
 

*System – controls Windows NT startup options.  Controls paging(swap) file and offers some diagnostic
                   information. 

Get more help with Windows NT

Insert Windows NT Server CD in CD-ROM drive.

Choose \SUPPORT\BOOK folder and double-click Server icon.

. 

Network Services - 

NT Server offers a variety of built in network services:

Computer Browser - Allows the NT Server to see a list of computers on the network

NetBIOS Interface - Support for older NetBIOS clients

Server Allows the NT Server to perform server functions

Workstation - Allows the NT Server to perform workstation fanctions

BOOTp Relay Agent - The original way for a server to dynamically assign clients an IP address

FTP Server - Provides a file server using the File Transfer Protocol

Gateway (and Client) Services for Netware - Provides File Sharing, Printing, and other Novell services to Novell   clients

Microsoft DHCP Server - The Dynamic Host Configuration Protocol allows the NT Server to assign

network information to clients such as IP addresses and gateways

Microsoft TCP/IP Printing - Provides print services via UNIX style LPR/LPD

Network Monitor Agent - Allows the NT Server to perform basic network monitoring functions via the Simple Network Management Protocol (SNMP)

Remote Access Service - Allows the Server to permit dial in connections

Remoteboot Service - Allows the NT Server to be used as a boot drive for remote clients

RIP for Internet Protocol - Allows the NT Server to route IP packets between LAN segments

RIP for NWLink IPXISPX Compatible Transport - Allows the NT Server to determine routes for IPX/SPX

traffic

RPC Configuration - Allows the NT Server to execute Remote Procedure Calls bn other UNIX systems

RPC Support for Banyan - Allows the NT Server to execute Remote Procedure Calls on other systems

using Banyan networks

SAP Agent - Allows the NT Server to send Novell Service Advertising Protocol messages

Services for Macintosh - Allows the NT Server to provide print and file services to clients

\Simple TCP/IP Services - Provides basic services to the NT Server. Other TCP/IP services require this before they can start

SNMP Services - Loads the SNMP client for remote computers to monitor the NT Server performance statistics

Windows Internet Name Services - Allows the NT Server to resolve local host names to IP addresses, necessary in a dynamically assigned IP environment

Identification - This is the field where the Computer Name and Workgroup are identified

Bindings - Bindings are the connection between the interfaces and the protocols / services

When multiple interfaces are used in an NT Server (such as an Ethernet card and RAS) the protocols and services are bound individually to each interface

RAS - Remote Access Service is used to allow dial in client to connect to the NT Server, or the LAN the server is on if routing is enabled. The bindings between the protocols and the interface are selected in the Network Setup panel, but the modem set up is configured under the Modem Option of the Control Panel and the modem connections and privileges are configured under Remote Access Administration from the Startup menu.

Restricting Logon Privileges to Assigned Workstations

You can restrict which clients on the network users can log on. This is accomplished by clicking the Logon To button from the New User and Copy of Username dialogs and the User Properties sheet to display the Logon Workstations dialog. [image: image8.png]i Backun Opnerators




NOTE: The workstations from which a user is permitted to log on is restricted to clients running Windows NT Workstations or Windows 95/98. Users of non-Windows NT or Windows 95/98 clients aren't affected by these settings. 
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By default, all new accounts-unless the account is a copied account and the account being copied has restricted access-can log on from all clients. If client logon access needs to be restricted, follow these steps:

· Select the User May Log On To These Workstations option.


· Type up to eight client computer names in the text boxes.


· Click OK to establish the restriction. 

When multiple users are selected from User Manager's window, the Logon Workstations dialog displays information that applies only to all selected users. By selecting the option User May Log On To All Workstations or by restricting client access, all selected users are affected.

Managing Account Information

You assign specific user account information by clicking the Account button at the bottom of the New User and Copy of Username dialogs and the User Properties sheet to display the Account Information dialog.

The Account Information dialog lets you determine the expiration date of the account and the type of account.

By default, a user account never expires. In situations where an expiration date is needed (such as when an employee leaves the company or for temporary employees), the account becomes inactive at the end of the day specified in the End Of date edit box.

The Account Type section specifies whether the account is global or local according to the following rules:

· Select Global Account if the user account must be recognized by other domains that trust the user logon domain.


· Select Local Account if the user logs on to the domain from an untrusted domain or if user access is to be restricted to the logon domain. 

The Account Information dialog can be invoked for multiple users. When multiple users are selected, only the properties common to all accounts are selected. Setting any of the options changes all selected accounts.

Setting User Dial-In Permissions

Windows NT Server 4.0 has eased the burden of granting dial-in permissions to users. In previous versions, dial-in permissions had to be assigned from the Remote Access Administration utility. Now dial-in permissions can be assigned directly from the User Manager by selecting the Dialin button in the New User and Copy of Username dialogs or the User Properties sheet.

By default, users do not have dial-in permission. Dial-in permission must be granted to each userIf your network's users need dial-in permission, simply mark the Grant Dialin Permission to User check box. Next, the Call Back options must be set. Three choices are available:

· No Call Back 

· Set By Caller 

· Preset To 

If you select Set By Caller, the user is prompted to enter an optional number that the server can use to call back the user. This option is very valuable for users who travel a great deal, need to access the network for information while on the road, and want to minimize telephone charges.

The Preset To option is limited because the server calls back to a specific number each time the user dials into the network. This option should be used only for strict security purposes where the user, usually a telecommuter, is always at a specific location.

System Administration

Server Manager

The Server Manager can manage NT Servers from a Windows 3.x, Windows 95 or Windows NT Workstation client. Software is located in \CLIENTS\SRVTOOLS directory of the NT Server CDROM Windows NT Workstation and NT Servers need a computer account to join an existing domain. Create computer accounts for NT Workstation or NT Server systems only, this prevents unauthorized NT systems. in your domain. The Domain Admin. global user group is added to the client system Administrators local group.

Creating a Computer Account - Open the Server Manager from the Administrators Tools program group, Choose Add to Domain from the Computer menu, Select the computer type, enter the Computer Name in the Computer Name Field, click the Add button, click the Close button.

Synchronizing the Domain Database

The Primary Domain Controller (PDC) holds the master domain database, a collection of user and computer accounts. The PDC copies the master domain database to the Backup Domain Controllers (BDCs) on a regular basis, defined by a registry setting. A synchronization of the BCD's database can be manually performed by the Server Manager. This may be done because of bad network conditions prevented regular updates.

Synchronizing the Domain Database - Open the Server Manager from the Administrators Tools program group, select the PDC, choose Synchronize Entire Domain, click the Yes button to proceed, click the OK button to begin

PDC and BDC Relationships

Microsoft NT Servers use Domain Controllers to store information to authenticate users. A user may be authenticated by either a PDC or a BDC. All User and Computer accounts must be created on the PDC's database. If the PDC goes down, no account modifications can take place. A BDC may be promoted to PDC to make account modifications. This will terminate all users connected to BOTH the PDC and BDC. Users should be warned prior to promoting the BDC. Never attempt to promote a BDC while connected remotely through a PAS connection on a domain controller.

After the original PDC is fixed and restarted two PDCs now exist on the network. No account modification can be made when two PDCs exist. If the original PDC has old account information, demote it to BDC. Synchronize the BDC to the PDC. Promote and Demote accordingly to restore the appropriate computer to PDC.

Promoting and Demoting PDCs and BDCs Open the Server Manager, select the computer to be promoted/demoted, from the Computer menu, select Promote to Primary Domain Controller or Demote to Backup Domain Controller, click the OK button.

Managing Services

The Server Manager can start, stop, pause, continue and configure system services on local and remote NT Servers and NT Workstations.

Before Stopping any services  Pause the service to prevent new users from connecting, send a message to connected users to allow them to save any work. Select the computer menu, Send Message. The Startup button changes the startup characteristics of the of the service. Startup Type can be Automatic, Manual or Disabled. Log On As allows die serve to use the default system account or a user account.

Managing Shares

The Server Manager can create, modify and remove shares on local and remote NT Servers and NT

Workstations. Open the Server Manager, select the computer, in the Computer menu choose Shared

Directories, from this windows New Shares may be created, Properties can modify an existing share and

Stop Sharing will remove an existing share.

Before Removing Shares - Removing the share immediately stops sharing, check to see if anyone is using the share before clicking the Stop Sharing button, or user data may be lost.

Resource Accounting

The Server Manager can be used to display the users connected, available shares and shares in use on local

and remote NT Servers and NT Workstations.

Open the Server Manger, select a computer and choose Properties. The Properties window contains:

Usage surtunary: The number of sessions are the numbers of users connected to the computer.

Users:
Displays which users are connected to the computer and what resources they are using.

Shares:
Displays which shares are available and who is using them on the computer.

In Use: Displays the resources that are currendy in use on the computer

Directory Replicator Service

The Directory Replicator Serve copies directories from a NT Server to another NT Server or NT Workstation. This service was intended to copy login scripts to other domain controllers. To have it work, the sending computer must have the Export server configured and the receiving computer must have the Import Server configured from the Server Manager Replication button.

Alerts

Alerts are used to notify administrators of the occurrence of a serious NT Server problem. To receive alerts the Alert and Messenger Service must be running. On NT Servers this is automatically started by default.

Configuring the Alert Service - Open the Server Manager, double click the computer name to select the Properties, click the Alerts button, enter the Computer or Username and click Add button, click the OK button.

Event Viewer

The Event Viewer is used to view event logs from the System Log, Application Log and the Security Log. The log files should be reviewed frequently to determine if there are system errors or security breaches that will effect the server performance. An NT Server creates a lot of events, Filtering mihimizes the number of events needed to be searched through. To prevent the log files from growing indefinitely, the events can be cleared, overwritten, or archived.

Viewing Events - Open tlie Event Viewer, select the log to be viewed, double click on the event to see the details.

Filtering Events - Open the Event Viewer, choose the View menu, Filter Events, in the Filter window specify the date and time range and types of events to be seen, click OK Once a filter has been applied the word Filtered" appears in the tide bar of the Event Viewer.

Log Settings - Open the Event Viewer, choose Log menu, Log Settings, from the Log Settings window the events can be cleared (erased), or overwritten after a specified number of days. To Archive the log:

Open the Event Viewer, choose the Log Menu, choose the Log Type, choose Save As, enter the type of file to save the log as, click OK Comma separated text may be read by Excel and most other databases.

Audit Policy - An audit policy should be planned for every server. This policy will include the frequency of log reviews (usually weekly), how long event information should be retained, where old events are to be archived (if at all), and who is responsible for these administrative tasks.

Repair Disk Utility

The Repair Disk Utility is used to create and update the Emergency Repair Disk~ This disk contains important files for restoring the NT Server. Before makiug any system changes run the Repair Disk Utility to backup the Registry. Keep this disk with the 3 boot disks created to install the server from CDROM.

Installing the Repair Disk Utility - Right click the Start button, choose Open All Users, double click the

Programs icon, double click the Administrative Tools icon, choose the File menu, choose New, choose

Shortcut, type RDISK at the command line prompt, click the Next button, click Finish.
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